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Part 1.  Session Contents 
1. Self-Intros 
2. What are your interests regarding Excel?  
3. What have your work experiences been with Excel (if any)? 
4. What questions would you like to have answered in this session (to be satisfied)?  

Zoom Screen Sharing for a F2F Session:  Zoom setup for the F2F session, so those sitting at the back can see my screen:  https://ksu.zoom.us/j/6752623021      (I will not be sharing sound via Zoom in a F2F presentation.)    
Fully Online Zoom:  For a fully online Zoom presentation, sound will be used through the web conferencing tool.

My One Goal Today:  I want you all to give Excel a try.  (Please don’t try to memorize how to use Excel.  I want you to just remember capabilities and maybe a referent name to that capability…and those capabilities and how to achieve them can all be found online (on web pages, in videos, and so on).  While there are some references to some more sophisticated capabilities, my plan is not to do walk-throughs of all of them…because the pacing of actually working these out is slower than the pace of a presentation.)  
If you already use Excel for work or pleasure, please just try some new function or feature of the tool.    
Use of Excel should be fun and stress free.  

Here is the general plan.  
	
HOUR ONE:  The Walk-throughs and Demoing 

· Creating a workbook (with spreadsheets) 
· Ingesting data (.csv / comma separated values; .tsv / tab separated values; database data tables, and others?) 
· Creating spreadsheets 
· Cleaning data (de-duplicating, removing untrustworthy data, removing anomalous datapoints for some types of statistical analysis, and others) 
· Filtering data 
· Applying simple formulas to data 
· Running a fill handle / using autofill (properly) 
· Navigating in the data 
· Searching and finding in the data 
· Creating data visualizations (based on the data, based on data visualization conventions) 
· Labeling data visualizations (in terms of axes, titles, data labels, legends, and others)
· Using built-in visuals [automated data visualizations (and starting to line up visuals with the data)] 

· Troubleshooting together 


	
HOUR TWO:  Some More Advanced Walk-throughs

· Intensity matrices / intensity tables by frequencies (conditional formatting - > color scales)  

· Combo charts with 2 y-axes (like a Pareto chart, which is a type of histogram) 

· Custom cell formatting (positive numbers; negative numbers; handling of zero) ; 
· Conditional formatting 

· Excel templates (Business, Personal, Planners and Trackers, Lists, Budgets, Charts, and Calendars) 

· Data downloads from various sites in Excel format 

· Using various add-ons to Microsoft Excel (such as some of the features of NodeXL or others)  

· Accessing and assessing all macros in an inherited Excel workbook, accessing and assessing all formulas in an inherited Excel workbook 

· Other topics (based on your own preferences)  




Part 2.  Some Basic Uses of Excel (O365)  

Excel is often used to achieve the following:  

· conduct calculations, 
· clean data, 
· graph or plot data (to identify data patterns), 
· create data visualizations (both static and interactive), 
· apply visual styles to data tables and data visualizations, 
· create interactive data visualizations (interactive pivot tables, interactive dashboards with slicers, and others), 
· create simple macros (sets of directions, scripts) for continuing data handling (with Visual Basic programming language), 
· process data for analytics in other software programs, 
· enable the share-ability of information, 
· access online survey data (in analyze-able format), and more 

Starting a Data Workbook:  
· An Excel workbook may be created from scratch manually.  
· It may be created from pasted data.  
· It may be created from available data in an existing file (which is loaded into an Excel workbook).
· It may be downloaded from a database.  
· It may be downloaded from an online survey system (like Qualtrics).  
· Or it may be created from some combination.  

Avoiding Data “Lossiness” (Data Loss).  Worksheets are limited to 1,048,576 rows by 16,384 columns.  (When using the computer “clipboard” to copy-paste data, those limits are lower, so be careful when moving data to make sure that you don’t permanently lose anything.)  
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Data Extractions from Application Programming Interfaces (APIs):  With add-ons and other packages, it is possible to conduct some data extractions from social media platforms (NodeXL/Network Overview, Discovery and Exploration for Excel), create data streamgraphs, and achieve other aims.  These are sometimes free.  (Make sure to go to trusted sites only to download these to avoid downloading malware lurking in some programs.)   
This Photo by Unknown Author is licensed under CC BY-SA

Connected Web Version:  There is a free Web version with a Microsoft account.  This is part of the Free Office Online apps (https://products.office.com/en/office-online/), which require a desktop browser and a Microsoft log-in.  

About the Online Version of Excel:  The online version of Excel has some limits in terms of features, but it offers other conveniences, like auto-save (to the cloud to the account on OneDrive and SharePoint), multi-device access, etc.  Figure 1.  The Quick Analysis Tool in Excel for an Initial Glance at the Data


[image: ]Engaging Quick Analysis:  

There are a lot of built-ins in Excel that enable fast exploration of data.  To access one, just highlight your data…and click the button at the bottom right.  

Those who prefer to make their own formulas may do so using pre-written formulas…  Or they can write their own formulas based on basic operands and directions (operations).  A relative cell reference is assumed in most cases.  This is when a selected cell is defined based on its locational relationship to the activated cell directionally.  For absolute (location defined and set) cell references, use the F4 or the $ in front of each part of the formula ($columnreferent,$rowreferent) to lock down the referent.  A locked-down referent uses the exact indicated cell again and again, and the referred-to cell does not change even if the original cell pointing to that target cell does.  (The default setting is to have relative cell references, unless otherwise indicated.)  

Data Visualizations from Excel:  
1. The data visualizations may be kept in the Excel file (.xlsx, not .csv file formats), and the Excel file may be shared. 
2. The data visualizations may be shared online on Office 365’s various Groups and SharePoint and others…for interactive experiential access and downloads.  
3. The visuals may be shared in a document as a linked visual to the underlying dataset.  Any changes to the underlying dataset will affect the data visualization. (This is done with a simple copy and paste from Excel directly.  The underlying data files should not be moved from the respective locations, or that will result in an empty visualization. The files are linked locally, so folder structures and names and such matter.)  
4. The visuals may be shared as a .pdf file (with text-readable text using screen readers).  
5. The visuals may be shared as a data graphic in either vector or raster / bitmap formats.  (In this case, the graph may be captured with a screenshot and rendered in a digital image editing tool.  Images do not carry inherent data in terms of screen readers, so the lead-up and lead-away text, the captioning, the alternative text…should all be as informative as possible.)  

Excel in a Work Pipeline
Work Sequences (or “Pipelines”):  Knowing what may be imported (into) and exported (out of) Excel is important because Excel may be part of a basic work sequence involving other technologies.  For Excel to be able to “talk” with these other software tools, it is important to know what the imports / exports file types are.  

File Versioning:  Also, these file types enable versioning…or creating different versions of a basic file…for uses in different contexts.  (The first “pristine” version of the dataset or workbook should be preserved in its original state, without changes, in order to protect the data against mishandling or unintended changing.  The individual can always return to the original data and start fresh.)  

Avoiding Data Loss

Avoiding File Lossiness:  Some file types are “lossy” and will lose information, so even if one starts out with a particular file type, it may make sense to save out the file in a different format.  

(One example is opening a .csv / “comma separated values” file of data but saving out as a .xlsx (XML spreadsheet) if you create data graphs and plots…because the .csv version will lose your visuals and result in repeated work.)  

Also, changing the data format of a data column may result in data loss.  One simple example is removing decimal places to the right of the decimal point.  Another is changing date information into general information.  The idea is to not accidentally create data problems.  (Keep a master file that is pristine and unedited so there is a backup.)  
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Description automatically generated]Ensuring visual quality in Excel workbook:  It is possible to place various digital contents, like images, into an Excel table as well.  If you need to retain high resolution, open a workbook with data.  Go into File -> Options -> Advanced -> Image Size and Quality -> and check on “Do not compress images in file” and set “Default resolution” to “High fidelity.”  Figure 2.  Preserving Digital Image Spatial Resolution with Pre-settings in the Excel Workbook

· Only then would you start loading in visual images by the “Insert” tab.  
· This setting is not retroactive.  






Import / Export File Types and Features  

	Import (file -> open -> browse -> file types) 
	Export
(file -> save as …) 
(file -> export …) 
(file -> publish … ) 
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Many use Excel to codify data tables for documents (in Word, in PowerPoint, in Adobe Acrobat), in databases, and in LaTeX files (for manuscripts, for dissertations).  

Part 3.  A Bit about Traditional Structured (Labeled) Data 

Basic Table Structure of Traditional Structured Data 

	
	Column Headers 
(usually variable data) …  
	
	
	
	
	
	

	Row Headers (usually individual records)  …  
	Data cells
	
	
	
	
	
	

	
	
	
	
	
	
	
	



Many datasets forgo actual labels to the columns if the contents are generally understood, or the documentation for the data is documented in a data dictionary or README documentation.  Excel accepts a number of structured data as imports.  

Common “Data Types” in Cells 
· Labels (usually as alphanumeric or text-only characters) 
· Values (usually raw numbers, dates, and others) 
· Formulas (directions to Excel for how to perform calculations) 

“Structured” data is labeled data, usually in data arrays or data tables. They are “structured” because they are formatted in ways that enable their processing in different software programs and of recognizable types.  [By contrast, semi-structured or un-structured data are textual documents, imagery, videos, audio files, mixed-modal files, and others, because these have more subtle types of structuring…not the explicit data table structures of classic quantitative data.  Some argue that there is no such thing as fully unstructured data because everything has some pattern, even if it is non-obvious to the naked eyes.]  Excel can handle both structured and semi-structured / unstructured data of various types.   
	Layout-wise, Excel has some challenges in handling images in its data cells, though.  It takes some work to center a series of thumbnails in a data cell…  Those who want the thumbnail to link to a full-size image need to make the image a link to the actual image (hosted on an available site).  

Data types take particular formats, and changing the data types in the column data can affect how the spreadsheet is ingested into databases (or not).  Changing the data types may also cause problems with the data itself and may lose specificity from some types of data to others.  Saving a workbook as a particular file type may also result in lost data if the format is not the right type to maintain the level of information.   

[Going with .xlsx and not .csv to maintain data visualizations:  For example, a file opened as a .csv but then edited to include data visualizations should be saved out as a .xlsx file to keep the visuals.  Otherwise, the data visualizations will be lost if the file is resaved as a .csv.]  Data visualizations are usually summary data, to capture higher level data patterns.  Some data visualizations may be made interactive in Excel, such as in pivot tables, data platforms with data filtering, and others.  

Data formats.  The data formats may be set for each column of data, assuming that the data is structured data and all of a type in the column.  The settings will affect how the cells are displayed and may change (numerical) input data…so it helps to know what the formatting is applied to each cell and how it affects the data.  (This is especially true with inherited data from databases, data tables sent by colleagues, downloaded datasets, and so on.  With inherited data or other types of data, always save a “pristine” master set before making any changes to the data…so you can go back to an anchor point before changes were made.)   

General:  default numbers, no understood format  
Number:  positive numbers, negative ones, up to 30 decimal places, may include the comma separator at each of three digits 
Currency:   any of hundreds of symbols for currency indicators, three-letter indicators for currency indicators, and others 
Accounting:  number representations for accounting, ( ) to indicate something of the amount, and others  
Date:  variety of representations of month, day, year; month; month-day, and other representations of 
[image: ]Time:  hour, minute, second and AM/PM; and other variations… and can filter by locale (for sense-making)  Figure 3.  The Representation of Large Numbers

Percentage:  percent values with a certain amount of decimal places (%) 
Fraction:  numbers of digits for fractions, fractional representations 
Scientific:  represents large numbers in exponential notation  

Text:  “Text format cells are treated as text even when a number is in the cell. The cell is displayed exactly as entered.”  
Special:  customized based on user needs (and enables text description of the “Special” type 
Custom:  custom data type with scripted handling of certain types of numeric data for more effective visual communications of numbers (directions, thresholds, frequencies, and others); applying rules or classes of rules to whole worksheet for every instance of the number:  [];[];[];[]; can use symbols to represent numbers 
 
[Resource Note:  A fun resource on using “custom” settings is available here:  https://youtu.be/tGY70sdpaLc.  There is a video on Excel shortcut key combinations:  https://youtu.be/Xe4U_-o_EWw.]    

Maintaining a pristine master set of Excel workbooks containing data.  The data types settings applied to the columns may change the data in the workbook, so save an original as a pristine master first before engaging with the data.  User error in filtering can also break row data integrity.  

Being security-conscious.  When accessing an online file or even an offline one with URLs, be careful about accessing hyperlinks.  Clicking on one hyperlink in an Excel file will enable all the hyperlinks in the file.  Be sure that you are receiving information from a trusted source.  
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Controlling for table width.  For those who have quite a few data columns and want to control for the width of a table, Excel enables fine-tuned controls.  
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1. Highlight the table.  
2. Go to the Home tab -> Cells area -> Format button -> Column Width selection.  
3. Put in the number in the window.  The measurements (by default) are by inches.  

Inherited Excel files.  To see all macros in an Excel file with macros, go to the View tab -> Macros area -> Macros button -> View Macros…and read the Visual Basic text to see what is happening in the script.  

Figure 4.  Seeing all Macros in an Excel Workbook with Macros Capabilities 
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To see all formulas in an Excel workbook, go to the Formulas tab -> Formula Auditing area -> Show Formulas button…  

Figure 5.  Seeing all Formulas in an Excel Workbook with Formulas
[image: ]



3D Mapping with General Place / Location Data 
· 3D Mapping Tour [Open Excel with the data.  Open the 3D Maps.  Select the data you want to include.  In the 3D Map dropdown, “Add Selected Data to 3D Maps,” and select desired data features to visualize.]
· The map is interactive and three-dimensional.  The visual can be changed to 2D as well.  
· A recorded video may be made of the visual changes to the map within the tool.  

Figure 6.  A Built-in 3D Maps Feature in Excel (requiring very light informational inputs)
[image: ]

The selecting of non-adjacent columns using the CTRL key while selecting columns does not work for the 3D mapping visualization.  
Interactive Pivot Tables (and Pivot Charts) for Summary Data Exploration 
· Need data to have variable names at top of data columns 
· Pivot tables for data summarization (includes recommended ones based on the data)  
· Need to save a data sheet as a table if the table itself will be updated with new data that should show up in the pivot table (vs. a static data table that will not be updated with new information)  
· Pivot charts for data summarization 
· Can create slicers from any of the data dimensions (right-clicking on the object in the column name variable panel)  

Figure 7.  A Pivot Table View
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Lookups for Individual Record Data Exploration / Queries:  
[image: ]
The lookups are by record…based on particular variables of interest.  Figure 8.  (Vertical and Horizontal) Lookups for Targeted Queries 

· If the column headers are used , then the VLOOKUP function is used.  
· If the row headers are used (as the main labels), then the HLOOKUP function is used.  

· VLOOKUP (Vertical Lookup) across rows (finding a value related to the leftmost column of data and a related corresponding value from another column, but in the same row, based on a defined relationship / formula)
· HLOOKUP (Horizontal Lookup) across columns (using a value related to the topmost row and finding a related corresponding value across columns…in rows)
· (V/H)Lookup Formulas:  (lookup_value, table_array, col_index_num, [range_lookup])  
· lookup_value = first value of interest (usually identifier) in the leftmost column or the topmost row 
· table_array = entire data table (extraneous data does not matter)
· col_index_num = column of interest by basic count (1, 2, 3…)
· [range_lookup] = true (if fuzziness or approximation or proxemic okay), false (if exact result desired) … The square brackets mean that an input is not needed. The default is “true” for approximated values.  
· For both, “named ranges” may be created to enable referencing multi-columns simultaneously using a named variable.  
· The arguments have to be set correctly the first time and can be re-used from there-on out…and shared with others.  The point is to test with simple data first…to ensure that everything is working as desired.  
· [Resource Note:  One helpful video is at https://youtu.be/E7gQ-PgYkMc.  For more on the new XLOOKUP, please check https://youtu.be/xnLvEhXWSas. ]  
[image: ]Figure 9.  An Index-Match Application on Open-Source USDA Data about Entrees and Accompanying Condiments 

Index- Match:   A more sophisticated approach involves using Index  -  Match.  A helpful video is at https://youtu.be/F264FpBDX28.  This involves indexing or mapping data (a column or a whole table, location-to-location in the data array) and then using a matching function (from one column to particular data)…to create an interactive dropdown that enables light data exploration.  



[image: ]Making a Dropdown ListFigure 10.  Creating a Dropdown List in Excel 


1. Click on a cell to activate. 
2. Go to Data tab.  Go to Data Tools area and Data Validation.  
3. Select Data Validation in the Dropdown.  
4. In the Dropdown, choose List.  
5. Identify the column source for the list (of identifiers).  
6. Select all.  (Keyboard shortcut:  CTRL + SHIFT + downwards arrow key (↓▼)
7. Click OK.  (This is a kind of workaround by using data validation to select in the contents that you want.)  




Creating Interactive Data Dashboards

· Set up the data in Excel.  
· Set up pivot tables in a new sheet (with the selected features).  Name the new sheet.  
· Analyze -> Pivot Chart…  Clean up the pivot chart data visualization.  Swap in the desired text for proper labeling.  Style it in the way that you want visually.  
· Make a new sheet for the dashboard.  Emplace the pivot table through copy-and-paste.  
· Continue until there are sufficient pivot charts.  Place them in a logical order from top-to-bottom (and left-to-right).  

To Make a Slicer in the Dashboard

· [image: ]Highlight a pivot table or pivot chart (interactive data visualization).  Go to the activated Analyze tab above.  Insert Slicer (an interactive filtering tool based on a selected dimension).  Select the data column variable used for the filtering.  The Slicer appears in the spreadsheet. Copy and paste it into the dashboard.  The Slicer is a visual interactive filtering feature on the dashboard.  Figure 11.  Inserting a Slicer after a Pivot Table or Chart has Been Made for Easier Interactivity with the Data by Users 

· Then, connect all the charts with the slicers.  Right click the slicer and select the Report Connections Region, and connect the slicer to all pivot tables. Do so for each slicer.  When mouse over-ing the slicers, the data visuals will change.  [Resource Note:  One video resource about creating a dashboard with slicers is available at https://youtu.be/RM8T1eYBjQY.]  

Dynamic Arrays in Excel…   A recent feature in Excel involves the built-in formulas that return arrays of data (collections of entities).  The main built-in array functions are FILTER, UNIQUE, SORT, SORT BY, SEQUENCE, RANDARRAY.  A detailed video about this functionality is available at  https://youtu.be/BsUTlhib4Tw.  A simpler and shorter video is here:  https://youtu.be/2USJsIyIzvo.  (This works on Excel 2019 and Excel in O365…with array formula features released in late 2018 and the update to Microsoft Excel’s calculation engine.)  [Ctrl+ Shift + Enter was used in the past for array formulas.]

About keyboard shortcuts, many of the common ones in the Microsoft Suite (esp. in Word) work the same in Excel.  More are available here:  https://support.office.com/en-us/article/keyboard-shortcuts-in-excel-1798d9d5-842a-42b8-9c99-9b7213f0040f.  

Working with Textual Data?  Excel’s “data” tab has some ways to subtotal counts of regularized text responses (such as from surveys). 
About the Data Tab:  The data tab offers a range of ways to sort, filter, clean, validate/invalidate, de-duplicate, group, and otherwise engage data.  

Figure 12.  The Data Tab
[image: ]

Finally, Why Excel?

Why Excel?  In Excel, you can work with the graphical user interface / visuals, built-in pre-set macros, and / or line formulas (for those who like command line-interactions).  Functions are represented multiple ways simultaneously for meaning-making.  Excel plays well with a lot of other tools.  Even if people use more sophisticated ways to engage data, it helps to know how to use Excel.  

If you’re just starting out, going to data.gov may be helpful because they offer a range of data and data type downloads for learning.  Many of the sharers of the data follow good practices, with README data, bylines and crediting, data dictionaries, data visualizations, data dashboards, and other elements.  

At K-State, we have access to the ProQuest TDM Studio (Text and Data Mining Studio), which enables various data visualizations…from shadow datasets…and related data that exports into Excel.  This web-based tool for text and data mining is made available by the K-State Libraries.  For information about how to access this tool, go to their website, and go to their subscription databases area…and look up “TDM Studio.”  

Original Release Date of Excel 1.0:  Sept. 30, 1985 (for our trivia fix)  


Presenter:  	Dr. Shalin Hai-Jew
               ITS, Kansas State University 
		785-532-5262
		shalin@k-state.edu 

Copies of this handout (evolving) may be accessed at the following URLs: 

PDF version:  https://idme-test.ome.ksu.edu/MSExcelO365.pdf
MS Word version (as a download):  http://www.k-state.edu/ID/MSExcelO365.docx  

[Updated:  2023] 


Part 4.  Typical Work Sequence (and sub-sequences) in Excel  (extra)  

1. Open Excel.  
2. Input data manually (using copy and paste or other means).  (Or capture by downloading data from a website or exporting data from a database.)  
3. Check the data for correctness.  
4. Save a pristine master of the data before any further processing.  Use informative naming protocols for the Excel workbook.   
5. Merge / combine / aggregate (union) selected data as needed.  (This assumes that there is an identifier column which enables the ability to match data between tables.)  
6. Clean and process the data (as needed).  
7. Select particular data ranges for study.  (Usually, data arrays are depicted visually in sections.  In some cases, full datasets may be studied simultaneously such as for factor analyses.)  
8. Explore and analyze the (selected) data through various queries, statistical analyses, and data visualizations.  Sanity-check the findings and results.  
9. Create a number of finalized data visualizations, and exported (or screenshot).  
10. Export the data in various formats for analysis in outside software tools.  
11. Archive.  
12. Create a sharable Excel workbook of data that is sufficiently de-identified / anonymized and with a README section.  (A README file usually addresses data sources, data representations, data table setup, contact information, and other relevant information.)  

A related workflow follows on the next page.  

[image: ]
image2.jpeg




image3.png




image4.png




image5.png
BB aRREERES

i+

formatting  Charts  Totals  Tables  Sparklines

EH =

DataBars  Colr.

Conditional Formatting uses rules to highiight interesting data,

dergr

1551





image6.png
General 1 Do not automtically hyperlink screenshot
Formulss Cut, copy. and paste
Dsts

Show Paste Options button when content is pasted

Procfing ‘Show Insert Options buttons.
Save Cut, copy, and sort nserted ojects with their parent cells
Language
" Link Handling
Accessvitty
Open supported hyperinks o Offic e in Offce deskiop a
] Open supported yper o aprs
Customize Ribbon. e
Quick Access Toolbar [] Use pen to select and interact with content by defaut
Addins Image Size and Quality | 3 Behavioral_Risk Fa... ~
Trust Center

) Disord edting date ®

Do ot compress mages inie®
Defautt resolution: @

Print

21 High gusity mod

Chart

Show chart clement names on hover
Show data point alues on hover

Propeties follow chart datapointfor all new workbooks®
Current workbook: [ @ Behavioral Risk

) Properties follow chart dats point fo current workbook





image7.png
Al Excel Files ~
(Al Files

Excel Files
|All Web Pages
XML Files
Text Files
|All Data Sources.
|Access Databases
(Query Files I
(dBase Files
Microsoft Excel 40 Macros
Microsoft Excel 40 Workbooks
Workshests
[Workspaces
Templates
|Add-ins
Toolbars
[SVLKFiles
Data Interchange Format
Backup Files

J OpenDocument Spreadsheet





image8.png
ne: [ Book!

pe: |Excel Workbook
i
Excel Macro-Enabled Workbook
Excel Binary Workbook

Excel 97-2003 Workbook

|CSV UTF-8 (Comma delimited)
XML Data

Singe File Web Page

Web Page

Excel Template

Excel Macro-Enabled Template:
Excel 97-2003 Template

Text (Tab delimited)

Unicode Text

XML Spreadsheet 2003

Microsoft Excel 5.0/95 Workbook
CSV (Comma delimited)
Formatted Text (Space delimited)
Text (Macintosh)

Text (Ms-DOS)

CSV (Macintosh)

Csv (Ms-D0s)

DIF (Data Interchange Format)
SYLK (Symbolic Link)

Excel Add-

Excel 97-2003 Add-in

POF

XP5 Document

Strict Open XML Spreadshect
| OpenDocument Spreadsheet





image9.png
Export

T Create Adobe PDF

Create Adobe PDF

% Create PDF/XPS Document

Fﬁ Change File Type

T
e
rioor

Convertto PDF using Adobe Acrobat
Viewable and printable on most platforms

Reliable and secure way of exchanging and archiving documents
Preserves original document look and feel




image10.png
Publish

1 publish o Power 81

Publish to Power BI

Use Power Bl to create and share rich visual reports and dashboards from your workbook. Learn more

You're signed in to Power Bl as shalin@ksu.edu. Use another account

Select where you'd ke to publish to in Power Bl

My Workspace

Export

Upload your workbook to Power BI
= Interact with your Excel workbook just a5 you would in Excel Onfine.
= Pin slections from your workbook to Power Bl dashboards.

= Share your workbook o selected elements through Power Bl

Export workbook data to Power B
= Export table data and data model into a Power Bl dataset.

= Create Power Bl reports and dashboards from your dataset.

Refresh




image11.png
4.3536E+04]
4.3550+04]
4.3550+04]
4.3551E+04]
4.3552E+04]
4.3552E+04]
4.3567E+04]
4.35726+04]
4.35736+04]




image12.png
Micost e eyl x
[

Hypertinks can be hamful o your computer and data. tis
important thatthis e s from 2 trustworthy source.

Cllcking yes will nable il the hypertinks i this il for this session.

Do you want to continue?

w =





image13.png
Fle  Home Inset Draw  Pagelayout  Formulas  Data  Review

View

Developer

Help  Acrobat  Power Pivot

[ ut " A" — wutoSum
D?“ TrebuchetMs <12 | A A P | BwapTe General | B By sERE -
[ Copy ~ Fill~
baste . o A- o | o 5 1 | Condiionsl Fomtas Cell | Insert Dol (SN
T Sromatrainer | B T U |H- |2 E $ - % 8 30 | Formatting~ Tablew Styles~ | v v | = || © Clear~
cpora i font 5 o T sois cas
F4 h i3 Done
AutoFit Row Height =
[ Column Width...
Aot Colam it
Default Widtt
i
Weekly Chore Schedule o
Hdeaumde >
Organize Sheets
7 Rename Sheet
Move o Copy Sheet..
Tob Color >
Doubleclick el §
David o Done under this column Protection
e
_--- e L [ [ [ [ | o
B LockCell
Dinner Dishes E
- { { f | [ | [ | [ | | | i
e
Mop
‘Weekly Chore Schedule @ <
Ready [E® % Accessibility: Investigate Average: 34924 Count:




image14.png
& Comments 15 Share

Acrobat  Power Pivot

‘+:1 h Bspit 0 E

View  Developer  Help

Review

Formulas  Data

Fle  Home Inset Draw  Page Layout
B E romss | Q[ B
I - Hide 0]
- Normsl page Eresc Page. CUstom | [ Grines | Headings | 200 100% Zoomto | New Amange Freeze Switch | |Macros,

i) ey Moo Selection | Window Al Panes~ (] i Windows~ | [
Workbook Views Show Zoom Window T viewMyros

116 - k3 [@ Record Macro...

| A | 8 | c | o 3 F | s | H | ) B UseRelative References





image15.png
File

B

Insert
Function

Home Insert

Draw

Page Layout  Formulas

Data

Review

]

@ @A o

[©]

AutoSum Recently Financial Logical Text Date& Lookup& Math &

v Used~

© v Time~ Reference~

Function Library

Tig

More
Functions ~

View  Developer  Help

@ efne Name ~
OB Guseinformia-
Manager B Create from Slection

Defined Names

Acrobat Power Pivot
B TacePecedens  VeShowFjuls
5 Tace Dependents A Eror Checking ~
PPt - @k s

Formula Auditing

Window

© Comments.

Calclate Now

Caleultion 2 ¢,jcuipte sheet

Options +

Calculation

1% Share




image16.png
Page Layout

Formulas.

Data

PivotTable Recommended

SRR

Pictures Online Shapes Icons

Review View  Help  Acrobat

Bicerse [ A

@ 30 Models -
Bysmartart

Power Pivot

Q Tell me what you want to do

1?

3 MyAdd-ins - Bing People Recommended

Line Column  Win/

Slicer Timeline

Equation Symbol

4 29 T Q

Text Header WordArt Signature Object

PivotTables Pictures - a4 Screenshot - Maps Graph  Charts Loss Box &footer - Line- -

Tables ustrations Addins Sparkines Fitters Links Text Symbols ~
02 - % | asia v

A | B | ¢ | D E | F | 6 | W | 1 | 3 | Kk [ L | ™ N | 0o | P | aQ | R | s T U | v [ w | x Yy | oz 8 Ac
1 |Ranking  Megacity Country _ Continent Population
2] 41 Bangalore India  Asia  11,800,000(3] © o 41Megacities3DMappingDemouisx - 30 May ?® -0 X
3] 24 Bangkok  Thailand Asia  15,931,30014] ot cend Fecdback
4] 7Beijing  China  Asia  24,900,000(7]
5] 45 Bogotd  ColombiaSouth Am 10,350,000[21] ] Create Video E GThemes - | DeienDon | [EH 9 2F Em | icwn EW e
6 30 Buenos Al Argenting South Am 13,834,000(17] aiCopturescreen | BN 25 Options | [9)Shapes - = A = et Box
7] 16Caro  Egypt  Africa  19,128,00006] f st~ bt 1o Locmton Resoms | ElLegend o o
s8] 35 Changzho China  Asia  12,400,000(7] Tour Scene Layer Map Insert Time View
Bl 20 Chengdu China  Asia 18,100,000(7]
10| 43 Chennai India  Asia 11,000,000(9] Tour 1 x = AddLayer *
1] 22 Chongain China  Asia  17,000,000(7] =
12] 4Delhi  India  Asia  27,20000009] o Nerar o7 x O
13 19Dhaka  Banglade Asia  18,237,000[6]
14 6 Guangzho China  Asia  25,000,000(7] ~ D
15 31 Hangzhou China  Asia  13,400,000(7]
16 44Harbin  China  Asia  10,500,000[7] B i 12 & =
17] 26 Istanbul  Turkey  Asia & Eur 15,033,000(3]
18] 3Jakarta  IndonesicAsia  31,500,000(8] Location 0%
19 420inan  China  Asia 11,000,0007] Contey ComgRegie X
20 23 Karachi  Pakistan Asia  16,900,000(3]
21 36 Kinshasa DemocraiAfrica  12,350,000(19] © Megeety v *X
2| 27Kolkata | India  Asia  14,423,000[15] Field List x + AddField
2 15 Kyoto-Osé Japan  Asia  20,337,000[6]
2] 14lagos  Nigeria Africa  21,000,000(13] Dragfields to the Layer Pane. Height
25| 37 Lahore  Pakistan Asia 12,200,000[9] 4 Range + Add Field
2] 47Uma  Peru  SouthAm10,072,000(6] Continent
27 29 London  United Ki Europe  13,842,667[16] Country Category
2 18 Los Angell United St North Am 18,788,800[11] Megacity et x
2] 8Manila  PhilippiniAsia  24,100,000(9] Population
30| 13 Mexico Ci Mexico  North Am 21,157,000[6] Ranking Time L
31 21 Moscow  Russia  Europe  17,200,000(3]
32| SMumbai India  Asia  23,900,000[3] * addfield
3 46 Negoya Japan  Asia 10,105,000[19] ) e
34| 40 Nenjing  China  Asia 11,700,000(7] L
35 10 New York United St North Am 23,876,155[11] . > Layer Options =
36] 34Paris  France Europe 12,405,426[18] e
37 38 Rhine-Ruf Germany Europe  12,150,000[20]
38| 32 Riode Jan Brazil  South Am 12,981,000[6] =
Sheet! ® [ o)

Ready Count:3  |NEH + 100%





image17.png
H S 41Megacites3DMappingDemo - Excel Shalin Hai-lew 1

M2 e m RedbEn fms B Gem Uso M e R Desion [N

PivotTable Name: - Active Field: ¢ ,r 3 Expand Field i ’-% @ @ T

PivotTabled Continent

b

Dl Dil 3 Refresh Change Data  Clear Select Move  Fields, tems, 0147 fclaio PivotChart Recommended | Field  +/=  Field
(R options ~ [§ fieias Down Up 76 - Soucer - - Phoflable  &Setst T PivotTbles | List Buttons Headers
PiotTable Adive Field Data Adions Goleulations Tools Show ~
A3 M fo Row Labels v
A | 8 c ) 3 3 s H ) K L ™ N o 3
1] ivotTable Fields ~ %
2
Bl ceunt ot anking Choose fieds to add toreport: | £+ ~
4 [EAfrica 3 oo 5
5| DemocraticRepublic of the Congo 1
6| Egypt 1
7| Nigeria 1
5 SAsia n
9|  Bangladesh 1
10| china 15 [ Population
1] e 5 More Tables
12| Indonesia 1 )
3| wan 1
14| Japan 3
15| Pakistan 2
16| Philippines 1
17| SouthKorea 1
18| Thailand 1
19| = Asia & Europe 1 e
20 Turkey 1
21| =Europe a Y Fitters Il Columns
2| France 1
23| Germany 1
24|  Russia 1
25| United Kingdom 1
26| =North America 3
2L e ; = Rows 2 Values
28 United States. 2
29| =South America s Continent __~ | [ Count of Ran... ~
30|  Argentina 1 Country g
31| Brazil 2
32|  Colombia 1
3| penu 1
34 Grand Total a7 -
| sheetz | Sheetd | Sheeti | sheets | @ [0 W [ LB et Upaie Update

Ready %3 [ E—TY




image18.emf
VLOOKUP across vertical columns 

HLOOKUP across horizontal rows


image19.png
Index and Match
Select Dis|Roast beef (eat lean &3t)
Condimer Horseradish sauce
Condimer Ketchup (catsup)

Condiment 5





image20.png
6] VA -28.0%)
e[ Data alidation X
A
o[ ] settings | input Message o atert
e[| vataation crteria
o[ ] aow:
A st Ignore blank
oot in-cel dropdown
between =
Source:
=5A52:5A555| *
Apply these changes to il ather cels with the same settings
Cearal oK Cancel





image21.png
- Brcel

Help  Acrobat  Power Pivot

FY

InettInsert Refresh ChangeData  Clear Se
SlitEr Timeline - Sourcer -

Fiter Data -





image22.png
Fle  Home Inset Draw  Pagelayout  Formulas  Data  Review  View  Developer  Help  Acrobat  Power Pivot © Comments & Share

% [RiFrom Text/CSV [ Recent Sources FS [0 Queries & Connections @ @ U:U AN Y:: Q £ Frash Fill 3= Consolidate. [E 'ZEE
Get

@ Advanced | Columns E Data Validation - (i Manage Data Model | Analysis~ ~ Sheet

=
2a)

Get & Transform Data Queries & Connedtions Data Types Sort & Filter Data Tools Forecast Outline 5




image23.jpeg
1 Open Excel

2 Export the
Data from a

PEIELER

2 Input Data 2 .Op.en 2 Download
Manually Existing the Data
Dataset or froma
Spreadsheet Website
Validate / Save a Pristine
Verify the| —— | Master Set (and Set
Data Aside)

3 Merge Data
As Needed

4 Clean Data
(reduce noise, address empty
cells, disambiguate)

5 Select Data for
Study

6 Run 6 Create Data
6 Explore the Data Statistical Yisualizations .
Analyses (for discovery, exploration
% and analysis)

6 “Sanity Check” the
Findings and Results

7 Create Finalized Data
Visualizations (for
Presentation and
Publication)

8 Export Data in Proper
Formats for Analysis in
Other Tools

9 Archive Workbook and

v

All Related Data, Visuals,
and Documentation

10 Create a Sharable
Excel Workbook that is
De-identified /

Anonymized and with a
README Section

A4

ia Close Excel




image1.png
Pagelsyout Fomulss Data  Review View  Help

B 3 [ [ G Qs -

< Bismanan
Recommended Table  Picures Onine Shapes Icons

Actobat

B et Adtins E

Bing People Recommended

Maps Graph

ProtTables Pictures - s Scrssnshot- | WMy Addns -
Bbies ustatons pesr
%

Book! - Excel

[ ——

=

1% i Q iy 1| ¥ El=

" Mops PivotChat 30 Line Column Win/ Sicer Timeine Link
Chars S Mepe Loss
chars 5 Tours Sparkines Fiters inks
3 L M N ° 3 a R s T

Shalin Hai-Jew

2 B0 4 o

Tet Header WordAtt Signature Object
Box &footer <+ Line-

T Q

Equation Symbol

Symbols

a8

5
35|
3
=
»
Sheet1 | Sheetz | Sheets | Sheets | Sheets | Sheets | @

Ready 23

—
.

The Excel Graphical User Interface




